CHAPTER 8

Performance Manager

An important component of efficient network management is the ability to receive performance
information on a large network of many devices to provide an overall view of the your user domain.
You can then pro-actively manage your network elements by analyzing the performance data.

The Cisco EMF Performance Manager provides the capability to monitor the performance statistics
gathered from network elements managed by the Cisco EMF system. You can set up the
Performance Manager to monitor particular attributes or parameters according to their network
requirements.

The Performance Manager is a powerful, flexible tool able to view general and performance specific
attributes in one application and in a variety of formats (for example, graphs and tables). You define
the attributes or parameters, choose the objects you want to view, select the date and time of the view,
and set the summary interval.

The Performance Manager is opened from the Network Maps, Event Browser, or Object Manager
applications by selecting Performance Manager from the pop up menu available on a selected
object. A window similar to Figure 8-1 is displayed.
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Figure 8-1 Cisco EMF Performance Manager

A selected object or group of objects has a number of different attributes. You can choose to monitor
an area of the network, for example, the performance statistics of a particular attribute. This
information could then be used to evaluate the performance of the vendor’s equipment and assess the
requirements for upgrades or software downloads.

Performance statistics also provide a summary view of the performance of network elements. These
statistics help you determine the degree to which the network is meeting assigned service levels. You
are able to drive down to the chassis level from the network level in a simple manner if you want to
view individual chassis statistics.

Cisco EMF Performance Manager can present data in two ways:

® Raw—this is performance data in its most detailed format (not summarized). History storage
criteria defines which attributes are to be monitored on specified objects. When these objects are
polled, the retrieved data is stored by Cisco EMF and can be viewed using the Performance
Manager. This data is raw data. History storage criteria may also specify summary intervals and
rules to be applied to the raw data. The resultant data is summarized data.

® Summarized—this gives derived summaries of raw data. This is an approach which displays the
data at a level appropriate to the task in hand; for example, you may decide to view data
summarized in hourly or daily intervals according to requirements.

Performance data has the potential to overwhelm. For example, you may wish to view the Errored
Packets for a device over a six month interval. If the data was displayed in a table or graph at the rate
at which it was sampled, this could be tens of thousands of values. In these circumstances, it is
preferable to view summaries of the data. For example, if data was originally received at intervals of
5 minutes, the ability to view it summarized in hourly, daily, or weekly intervals would be an
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History Storage Criteria

excellent way of managing the network. History storage criteria can be used to specify these
summary intervals and the rules which are used to generate the summaries for the history storage
criteria’s objects and attributes.

Hourly summaries are generated on the hour, daily summaries are generated at midnight, and weekly
summaries are generated at midnight on Sundays (that is, the end of Sundays). For example, if
polling starts at 9:30 and hourly summaries are to be generated, the first full hour’s worth of data will
be between 10:00 and 11:00. So at 11:00, the first hourly summary is generated, and given a
timestamp of 10:00. The same pattern is followed for all summaries (daily, weekly, or user-defined).
This pattern standardizes summary intervals so all attributes’ summaries have the same timestamps.

Note Data generated between 9:30 and 10:00 is ignored in the above example because an hourly
summary for 9:00 to 10:00 would be misleading as it would have been generated using only half the
usual number of values.

In some cases, an object may fail to be polled; for example, if communication to the object is lost.
This is referred to as a missed poll, and all missed polls are indicated on Performance Manager
graphs and charts.

Performance Manager graphs and charts also indicate when an attribute started and stopped being
polled due to history storage criteria being added, edited, or removed. You are therefore able to see
when polling on an attribute started, the attribute’s values while it was being polled (and any missed
polls), and finally when the attribute stopped being polled.

A Performance Manager can be opened for each network element you wish to monitor. To view
up-to-date information on the Performance Manager, select Refresh and the selected data is
displayed.

The Performance Manager also allows you to specify how the data is saved or printed, either to file
or printer.

History Storage Criteria

History storage criteria allows a system administrator to specify the criteria Cisco EMF uses to store
a historical record of attributes’ values. Each history storage criteria can be identified by a unique
name.

History storage criteria apply to a set of network elements and to a set of attributes on each of those
elements. For each attribute on each network element specified in the history storage criteria, Cisco
EMF stores and manages a historical record of the attribute’s value.

Note If no history storage criteria are specified, no attributes on any objects are monitored.
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Opening the Performance Manager

Opening the Performance Manager

The Performance Manager can be accessed from pop up menus on selected objects in the following
applications:

® Network Maps
® Event Browser
® Object Manager.
Step1  Open the appropriate window to display a relevant object.
Step2  Place the cursor over the object.
Step3  Press and hold the right mouse button.
A pop up menu is displayed.
Step4  Move the cursor until the Performance Manager option is highlighted.
Step5  Release the right mouse button.

The Performance Manager window is displayed.

Figure 8-2 Performance Manager Window
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Refresh Bar chart

From the Performance Manager window you can:
® Identify all monitored attributes on a selected managed object
® Identify all time periods configured for sampling each monitored attribute
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Viewing Performance Statistics

® Identify all summary methods configured for selected monitored attributes and
selected summary periods

® View historical performance data over a requested period of time (in tabular or
graphical format)

® Print performance data to a printer or file.

Viewing Performance Statistics

To view performance statistics, you need to select:

® which attributes performance statistics are to be displayed

® the time period over which the performance statistics are gathered

® the format to be used to display the results.

Step 1 Open the Performance Manager. The window shows the name of the selected object.

Step2  From the Monitored Attributes list, select the attribute to be monitored.

Note You can select multiple attributes in a list by holding down the Shift key and
selecting attributes in the list. You can select multiple individual attributes by holding
down the Ctrl key and clicking individual items. The information for all selected
attributes is shown in the Table Display. Only the first selected attribute is shown in the
Line Chart or Bar Chart.

Step 3 In the Start Date data entry boxes, enter the date the view of the performance statistics
has to start from. The format is <mm>/<dd>/<yyyy>.

Step4  You set a start time and an end time using 24 hour notation. The times are inclusive. In
the Start Time data entry boxes, enter the time the view of the performance statistics has
to start on the Start Date.

Step5  To set the End Date you have two options:

In the End Date data entry boxes, enter the date the view of the performance statistics has
to stop at. The format must be <mm>/<dd>/<yyyy> or select the Now check box to view
the data from the selected start date to the current time. By selecting this option, you do
not have to update the End Date and End Time fields.

Note Now is the current time, and remains current.

Step6  To set the End Time you have two options:

In the End Time data entry boxes, enter the time the view of the performance statistics
has to stop on the End Date or select the Now check box to view the data from the
selected start date to the current time. By selecting this option, you do not have to update
the End Date and End Time fields.
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Viewing Performance Statistics
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Step 7

Step 8

Step 9

From the drop down list, select the Summary Interval rule to be used. This varies
according to the attribute selected. The summary interval is the period of time over which
the rule is applied. This drop down menu always contains the option to select raw. This
displays the data in raw format, which is performance data in its most detailed format (not
summarized).

Note When raw is selected, the Bar Chart view is not available and the Summary Rule
option is grayed out.

From the drop down list, select the Summary Rule to be used. This gives you the option
to summarize data to a lower granularity as follows:

® Total—totals all values gathered in the summary period

® Average—takes the average of all values gathered in the summary period
® Min—presents the lowest value received over the summary period

® Max—presents the highest value received over the summary period

® LogicalOR—displays either 1 or 0. This is typically used for status flags. Some
attributes may have only two potential values (such as, true or false; yes or no; 1 or 0).
When summaries are generated from values such as these, and the “logical OR” rule
is used, the summarized value is 1 if any value in the summary interval is 1. If all
values in the summary interval are 0, then the summarized value is 0.

Note The Summary Rule option is not available when the option to view raw data is
selected.

Click the Refresh button.

Note The Refresh button is blue when it is available for selection. It is grayed out when
not available. The Refresh button is available for selection when Now is selected, or
when any criteria has changed and you have moved the cursor away from the changed
value by pressing the Tab key or by using the mouse.

By default, a line chart of the performance information, to date, is displayed. You can
view performance information in the following formats:

® Line Chart, refer to Figure 8-3
® Bar Chart, refer to Figure 8-4
® Table Display, refer to Figure 8-5.

The performance information displayed corresponds to the attributes’ raw values. If a
summary period is selected, the information is displayed according to the summary rule.
No summary period is associated with raw data.
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Viewing Performance Statistics

Note In some circumstances, possibly due to Cisco EMF being shut down or heavy
network load, an object may fail to be polled. This is a missed poll. All missed polls are
indicated on Performance Manager graphs and charts by a yellow point. This shows the
last valid value collected. A missed poll affects the summary data and the data should not
be relied upon.

Performance Manager graphs and charts also indicate when an attribute started and
stopped being polled due to history storage criteria being added, edited, or removed. Start
and Stop polling events are shown in charts and tables:

® The Start polling events point is shown in green

® The Stop polling events point is shown in red.

Note A Polling Events key is displayed.

Figure 8-3 Line Chart Example
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Figure 8-4 Bar Chart Example
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Viewing Raw Data

Figure 8-5 Table Display Example

Hissed Poll Missed Poll
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Viewing Raw Data

Cisco EMF provides the option to view raw data as it is received without any summarization. History
storage criteria define which attributes are to be monitored on specified objects. When these objects
are polled, the retrieved data is stored by Cisco EMF and can be viewed using the Performance
Manager. This data is raw data. History storage criteria may also optionally specify summary
intervals and rules to be applied to the raw data. The resultant data is summarized data.

Note The Summary Rule option and the Bar Chart view are not available when the option to view
raw data is chosen.

Step1  Launch the Performance Manager.

Step2  Choose the desired attributes and set the dates and times as described in the “Viewing
Performance Statistics” section on page 8-5.
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Viewing a Chart

Step3  From the Summary Interval drop down list, select raw.

Step4  Click the Refresh button. The new performance information displayed corresponds to the
attributes value returned during the raw period.

Note The Refresh button is blue when it is available for selection. It is grayed out when not
available. The Refresh button is available for selection when Now is selected or when any criteria
has changed and you have moved the cursor away from the changed value by pressing the Tab key
or by using the mouse.

Viewing a Chart

You can zoom in, zoom out, and move around the displayed charts by using the following keys and
mouse buttons. Note, you must select a chart before invoking the following actions.

Table 8-1 Chart Viewing Actions

Press Action

Shift and left mouse button To select multiple attributes in a list.

Up arrow key Scrolls up the Table display.

Down arrow key Scrolls down the Table display.

Left mouse button Clicking and dragging with the left mouse button over an area zooms in on

that section of the chart. You cannot zoom in on a chart that has a scroll bar.

Middle mouse button Takes the view back one “zoom” after zooming in using the left mouse button.

Viewing Points and Values on a Line Chart

You can choose to annotate a line chart with color coded points which represent the polling status.
You can also show the values associated with each point.

Step 1 From the View menu, select Points. This annotates the line chart with points, which
visually indicate the points which are presented in tabular form in the Table Display. A
point is colored coded to show polling status as follows:

® Black—poll

® Red—stopped polling
® Green—started polling
®  Yellow—missed poll.

Step2  From the View menu, select Values. This option shows the values associated with each
point, which are presented in tabular form in the Table Display.

The values are shown on each chart until the item is deselected in the View menu.
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Printing a Performance File

Printing a Performance File

You can print performance statistics from the Performance Manager, either as a chart or as a table.
A chart prints out the information which can be seen in the window. A Table prints out all of the
performance statistics in a plain text format.

The output is printed by the default printer set up on your network.

Step 1
Step 2

Open the Performance Manager and select the desired performance statistics.

From the File menu, select Print. Choose either As Chart or As Table.

Saving Performance Data to a File

No performance data is saved automatically. If you want to save data, you must select Export to File
to save the current data to a file.

Step 1
Step 2

Step 3

Step 4

Step 5

Open the Performance Manager and view the performance statistics you want to save.

From the File menu, select Export to File or

click the Save As icon %| from the Toolbar.

The File Chooser window is displayed. The left hand panel displays the directories and
the right hand panel displays the files. Use the scroll bars to locate the desired file. Click
Filter to expand the list of options.

Select the file. The full path name of the selected file is displayed in the File Filter box,
as well as the Choice box.

Note You can save the data to a new location or to a new file. Type in the new names as
required in the Choice boxes.

Click Apply to save the file or Cancel to return to the Performance Manager window.
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Saving Performance Data to a File
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